
 
WIN-CNC 

Windows - CNC Communication / Editing Software 
for Cincom Machines 

 
 
 
 
 

 

 

 WIN-CNC

 
 



 
 
 
 
 
Thank you for purchasing this software package. WIN-CNC is designed 
specially for the Citizen Cincom CNC Lathes. WIN-CNC will work with most 
Fanuc controls and also many others.  
 
In most cases all the information you will need is in this manual. The most 
common problem we have found is with the cable connecting the CNC 
machine and the computer. Please confirm that the cable wiring is correct 
with the diagram in this manual on page 5 before you call. 
 
Thank you again and we hope you enjoy your new CNC communication 
and editing software package. 
 
 
 
 
 
Marubeni Citizen-Cincom, Inc. 
 
E-Mail: software@mctz.com 
Internet: www.marucit.com/software 
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Installation 
 
Run the SETUP.EXE program from within Windows and the files are un-compressed 
and copied for you. If you have the internet demo version installed then use Control 
Panel to uninstall WIN-CNC first, then install the new one. No CNC programs will be 
lost!, but your ID number will change. 
 
Setup.exe  Win95/98/ME/NT/2000 - Assuming your floppy drive is A: , from the Start 
button click on Run. Now type A:SETUP (enter).  When the installation is finished, use 
the Start button and Programs then click on WIN-CNC to start it for the first time. You 
will now be asked to setup specific Citizen Cincom machines. This will make different 
folders for each model and also if you choose, will make shortcuts to each on the 
desktop, or in the Start-Programs-WIN-CNC menu. 
See - Getting Started Pg. 6 before using WIN-CNC. 
 
Problems During Install:  
If any errors occur during installation, close all other applications, reboot Windows and 
run setup again. If an error continues please use Windows Scandisk to check each 
floppy disk. Possibly there was damage in shipping. 
 

Password 
 
When you run WIN-CNC for the first time, you will be prompted for your registration 
information. The software will run for 15 days so please fax or send by e-mail the 
information as soon as possible so we can send you back your unique password. Each 
copy of WIN-CNC is allowed 3 installs on 3 different PC’s. If more are needed, you will 
need to purchase additional copies. Sorry, we was forced to add this protection! Please 
read the Password screen and e-mail the data as shown. 
 

Serial Communication Cable Configuration 
 

 computer-25 pin CNC-25 pin     computer-9 pin CNC-25 pin 
 
     2--------3        2--------2 
     3--------2        3--------3 
     7--------7        5--------7 
 jumper       4-5  4-5    jumper          7-8  4-5 
 jumper      6-8-20  6-8-20   jumper       1-4-6  6-8-20 
 
A serial communications cable can be purchased from your nearest computer store, 
then made to work. You might also need a RS-232 jumper box,  Radio Shack PT# 276-
1403, and solder it like above. You can make the cable yourself without the jumper box 
and solder it like above because all that we need is 3 wires, the rest are jumped signals. 
A null modem cable can now also be used for most CNC machines.  
 
Note: If you use the jumper box from above, configure the cable as a 25pin-25pin, the 
cable changes to 9pin to 25pin for you. 
 
USB- If all you have is USB ports on a laptop, a USB-Serial adapter is required! 
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Getting Started 
 
1) To start the program, from the Windows,  click on the Start-Programs-WIN-CNC 

icon. To change some of the defaults see Command Line Options below. You can 
also browse through the Windows Explorer and double click on any “.CNC” file, WIN-
CNC will load that file automatically. 

 
2) Choose  Param  from the Main Edit Window drop down menu. To do so press Alt-

P or use the mouse.  -See page 31, Change Parameters 
 

 
 
3) Set all the parameters and the machine type to your needs then choose the Save 

button. The communication parameters will be called up every time the currant folder 
is used. If you have more than one type of machine, make a different folder for each 
type. Set and Save the parameters in each folder for each machine. The installation 
will create the folders for you but you may have to add some machine types at a later 
date. 

 
Command Line Options 

 
There are a few command line options that can be used when running WIN-CNC. 
   WINCNC2K2.EXE   c:\cnc\anyfile.cnc  /RV=109 
 c:\cnc\anyfile.cnc -Used to load a file at startup. It must be first on the line. 
 /RV=  -This is used to change the Data Pg format for L3-series machines 
  Rom Ver  109  112  115 can be selected. 
    
This is done by changing the properties of the WIN-CNC program Icon and adding the 
command line options to the Target. Change Target to your needs.  example: 
“C:\Program Files\WIN-CNC\WINCNC2K2.EXE  /RV=109” 
 
Use Explorer and go to “\windows\start menu\programs\WIN-
CNC” folder and right click on the WIN-CNC icon. Then click on 
properties. Click on “Short cut” then change the line “Target” 
like above.  
 
You can also use Start-Run and input  
WINCNC2K2.EXE /scsetup   this will run the shortcut and folder 
setup again if you are adding some new machines at a later 
date. 
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Using The Files Window 
 
The Files Window is called up when any of the Main Edit Window choices are made 

that need to access the files on the disk. A special file in each folder has machine 
information and parameters saved in it that help identify each folder as you browse 
around. Please don’t edit or delete the file WIN-CNC.PRM from any CNC folder. 

 
1) Just pick a file name by typing the name in the File Name: text box, then press 

(Enter or OK). You can also press (Tab) or Alt-N to move to the Files: list box, Then 
use the arrow keys and press (Enter or OK) on your choice. 

 
2) Drives:  Press (Tab) or Alt-V to change to the Drive: list box, then press the drive 

letter to change to, example  A  . This will change the directories and files also. 
 
3) Folders:  Press (Tab) or Alt-D to change to the Folder: list box.  Use the arrow 

keys and press (Enter or OK) on your choice. This will change the files also. 
 
-You can also search by pressing the first letter of a file or folder to move the menu bar. 
 
-The default file extension is .CNC . Using this extension enables the first line of the file 

the menu bar is currently on to be displayed for better identification. You can show 
only the files you like by changing the File: text box to *.* or *.CNC;*.TXT  or change 
FileType: 

 
-Default File Name Example... 

 TESTFILE.  = TESTFILE. 
     TESTFILE  = TESTFILE.CNC 
If you input (.) then the default is not used, you are specifying the extension yourself. If 

the (.) was left out then the default of   .CNC will be added automatically for you. This 
can be changed on the Options menu by changing the default file spec. 

    See page 11 to change the default extension. 
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Main Edit Window 
 
The benefit of this software package is the ability to edit 3 program columns at one time. 
For example the E/M-Series machines have $1-$2-$3 and the L-Series V-VII has $1-$2 
 
To get started, simply start typing. You can press Alt to access the drop down menu, 
then the highlighted letter of each menu choice, or use the arrow keys to maneuver 
around.  Or press the Left Mouse Button on your choice to access the menu bar. 
Following are examples of all the editors abilities. 
 

 
 

Drop down Menu Choices 
 
File    Alt-F  
   New    Alt-F N 
   Open   Alt-F O 
   Save   Alt-F S 
   Print    Alt-F P 
   Print Setup   Alt-F U 
   Seek Files   Alt F E 
   1 - 5    Alt F 1-5 
   Exit    Alt-F X 
 

New This will prompt you to choose the folder for the New file and open a new 
edit window. Then it will call the Data Page Window so you don't forget to 
set the Machining data. After setting the data, the common CNC code is 
added for you to save extra typing. 

 
Open This will call the Files Window, for you to choose a file name to load from 

disk into the editor. (see Pg. 7 Using The Files Window) 
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Drop down Menu Choices (cont.) 
 
Save This will call the Files Window for you to choose a file name to save your 

CNC program to disk. If the file is already there then you are prompted to 
overwrite it or not. (see Pg. 7 Using The Files Window) 

 
Print Print the current program loaded in the editor. The print format is unique to 

each Cincom model. One, two, or three columns of text. If a single line 
program is used then you can choose 1-3 columns for the single line 
program to be printed side by side to save paper. 

 
Print Setup First choose which printer to use then you can set the left margin if 

needed to put your programs in a 3 ring binder. You can also set the 
printed font style and size. You can use Send Text to Printer to save time 
printing on dot matrix printers.(not so common any more) 

 
Seek Files The Seek Window will be called. Input a file name or use wildcards 

like “*.cnc” then press Search. Double click on the file found and it will be 
called into the editor. 

 
1 C:\CNC\L20VII\SAMPLE.CNC  Fast load one of the last files edited. 

This will save you the time looking for the file in the Files window. 
 
Exit If the program has not been saved and was edited then you are prompted 

to save the file first, otherwise WIN-CNC is terminated. 
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Drop down Menu Choices (cont.) 
 
Edit     Alt-E 
   Undo Ctrl+Z   Alt-E U 
   Cut  Ctrl+X   Alt-E T 
   Copy Ctrl+C   Alt-E C  see page 13 for examples 
   Paste Ctrl+V   Alt-E P 
   Select All    Alt-E S 

 
 Undo -Undo the last edit. If you hit the delete key by accident? Only one level of 

undo is available. 
 
 Cut -Deletes the current selected text and stores it in the clipboard. 
 
 Copy -Stores the current selected text in the clipboard.  
 
 Paste -Inserts the clipboard contents at the current location.  
 
 Select All -Selects all the text in the current editor. 
 
 
View     Alt-V 
   Fonts    Alt-V F 
   Edit Background Color  Alt-V B 
   Window Background Color Alt-V W 
   Line $1  F1  Alt-V 1 
   Line $1 Min/Max Ctrl+F1 
   Line $2  F2  Alt-V 2 
   Line $2 Min/Max Ctrl+F2 
   Line $3  F3  Alt-V 3 
   Line $3 Min/Max Ctrl+F3 

 
Fonts -Displays a list of fonts to choose from. Also the font color can be 

changed. 
 
Edit Back Color -Choose the background colors for the text in the editor. 
 
Window Back Color -Choose the background colors for the area behind the text 

boxes. 
 
Line $1-$3 -Press F1-F3 to move around to $1-$2-$3 
 
Line $1-$3 Min/Max -Press Ctrl+(F1-F3) to maximize the editor for better 

viewing. You can also click the mouse on the label    Line $   above the 
editor. 
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Drop down Menu Choices (cont.) 
 
Search    Alt-S 
   Find              Alt-S F 
   Find Next  Shift+F3  Alt-S N 

 
Find -This will call up the find window to locate text. You can also select text, 

then start find and the selected text will default to the search text. A great 
tool added was search by value. So if you searched for “X.5” and your 
program had “X0.5” the search would not find it. If used “Match Value” the 
text X.5 and X0.5 would be the same. 

 
 
Options    Alt-O 
   Toolbar    Alt-O T 
   Default File Extension  Alt-O E 
   Default File Spec   Alt-O S 
 

Toolbar -Hides/Shows the toolbar Icons. This could be used to have more 
viewing area of your programs. 

 
Default File Extension -When WIN-CNC is loaded   *.CNC  is used as default. 

When saving files and no extension is used then this extension is added to 
the file name automatically for you. See page 7 for details. 

 
Default File Spec -When the files window is loaded   *.CNC  is used as default 

for the types of files to be listed. You can show only the files you want so 
the operators don’t edit the wrong files.  Example   *.CNC;*.TXT  would 
show only files that end with TXT and CNC. All others are not listed. 

 
 
Window    Alt-W 
   Cascade    Alt-W C 
   Tile     Alt-W T 
   Arrange Icons   Alt-W A 
   1 C:\WIN-CNC\Program1.CNC 
 

Cascade -Arranges all the open edit windows in rows to be able to find any 
hidden behind. 

 
Tile -Arranges all the open edit windows to be sized to fit the screen at one 

time, to see the entire window of each. 
 
Arrange Icons -Lines up all the minimized Child windows of WIN-CNC in a 

row at the bottom of WIN-CNC. 
 
1 C:\WIN-CNC\Program1.CNC  -All the current windows are listed so you can 

choose the one you want easily from the bottom of the menu. 
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Drop down Menu Choices (cont.) 
 
Param   Alt-P 
 

Param  -Open the communication parameters menu. See page 31, 
Change Parameters Menu, for details. 

 
 
Comm  Alt-m 

Communication -Calls up the communication window to send / receive files. 
See page 24-29 

 
 
Cnc   Alt-C 
Prog   Alt-R 
   (same as the Toolbar buttons but accessible by the menu) 
   Make Peck Drill Sub Program 
   Make Engrave Sub Program 
   CNC Line Numbers 
 

(Toolbar buttons) -Same as Toolbar but using the keyboard. 
 
Make Peck Drill Sub   -This is used to write a sub program that will peck the drill 

as needed, if you don’t have any drill cycles on the CNC. See page 19 
 

Make Engrave Sub   -This is used to write a sub program that will engrave 
letters using any axis letters, linear or polar. See page 19 

 
CNC Line Numbers   -This is used to insert sequence numbers in a program. 

Also to remove sequence numbers as needed. See page 20 
 
 
Help   Alt-H  Access the Help menu 
   M-G Codes  Alt-H M Call the M-G code Help Window 
   Editor Help  Alt-H E Call the editor Help Window 

 
M-G Codes -Calls the help file for the current machine type. You can browse 

around or search to a specific G or M code. You can also copy examples 
to your program. 

 
Editor Help -Shows the commands for the editor on the screen. 
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Special Key Combinations 
 
Ctrl-Left Arrow = Move the cursor one word to the left 
Ctrl-Right Arrow = Move the cursor one word to the right 
F1-F2-F3 = Switch between $1-$2-$3 programs 
Ctrl+F1-F2-F3 = Expand the current window to the full screen 
Home / End = Move the cursor to the Start / End of the current line 
PgUp / PgDn = Display the previous / next page 
Ctrl-E = Information about combination center drill countersinks 
Ctrl-D = To view or change the Machining Data Page (not all machines) 
Ctrl-F = To search for some characters in a program 
Ctrl-M = M-G code help screen. Only for certain machines 
Ctrl-S = SFM and RPM information 
Ctrl-H = Shows help screen with all the above key strokes 
Ctrl-A = Calculator for trig. or any function 
Ctrl-T = Thread programming  G76/G92/G32 
Ctrl-L = Tap Drill Information 
Ctrl-G = Triangle info. Trig 
Ctrl-R = Radius Compensation help 
Ctrl-C = Copy text to clipboard 
Ctrl-V = Paste text from clipboard to editor 
 
 
 

Block Operations - Copy / Delete Text 
 

Copy Blocks of Text 
1) Move the cursor to the first character to be copied. 
2) Press and hold down the Shift Key. 
3) While holding the Shift Key down, press the Arrow Keys and your text will be 

highlighted or Marked. Or drag the mouse to highlight. 
4) Now you can release the Shift Key. The text is still Marked. Press Ctrl key and hold 

it down then press C key to copy the Marked text into a temporary buffer. 
5) Move the cursor to the place you would like to copy the text to. 
6) Press and hold the Ctrl Key again and press the V Key. The text in the buffer is now 

inserted into your program. 
 

Delete Blocks of Text 
1) Move the cursor to the first character to be Deleted. 
2) Press and hold down the Shift Key. 
3) While holding the Shift Key down press the Arrow Keys and your text will be 

highlighted or Marked. Or drag the mouse to highlight. 
4) Now you can release the Shift Key. The text is still Marked. Press the Delete Key to 

remove the Marked text.  
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Main Edit Command Buttons 
 
I have put together a group of tools used to help you write your CNC programs without 
accessing all different notes of your own. Some are unique to the Swiss type machines 
but others are just nice to have and save a lot of time programming. Each one is 
explained below. 
 
-Any of the tools that have some form of answer, you don’t need to remember it. When 
each window is closed the answer is displayed in the lower left of the Main Edit 
Window’s status bar. 
 
-If you use metric programming and use inch threads or inch center drills etc.,  then the 
inch data is converted to metric for you. Or metric data is converted to inch.  
 

Find 
 
Click on the menu Search and then Find. Use Find to find or search for text in your 
program. If you are in $1 then Find will only look in $1 for the text. The Find window will 
always stay on top while in use. You can also search by value so “X.5” would find 
“X0.5”. 
 

Center Drill Info. 
 

Click on Cen-Drill to call up the Center Drill chart. Input the hole size to drill and Tab to 
the next text box. Set either the chamfer amount or the chamfer diameter and press Tab 
again. The Center drills you can use will be displayed and also how deep to feed, to get 
the desired chamfer. 
 

 
 
The file  CEN-INFO.TXT  has the center drill data stored in it. If you have a special type 
of center that you use as your standard, you can edit CEN-INFO.TXT  and add it to the 
list. You can use metric or inch centers and the data is converted for you. 
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Main Edit Command Buttons (cont.) 
 

SFM 
 
Click on SFM. Input the diameter and  Tab to the next data. The data calculates after 
every key press. If you are using Metric then SFM = SMM 
 

 
 

Threading 
 
Click on Thread. This will help you input the code into your program to cut threads. 
Choose the thread type and G-Code to use. Then fill in the rest of the data. When 
finished, the code will be inserted into your program for you. If your thread type is not in 
common thread then set the thread type to non common thread and set the data 
manually. 
 

 
 
The file THREAD.TXT can be edited and you can add any special threads that you cut 
often. Just look at the notes in the THREAD.TXT file. If you have metric threads the 
data will be converted for you to run in inch, or inch to metric. 
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Main Edit Command Buttons (cont.) 
 

Tap Drill Info. 
 
Click on Tap Drill. This is a fast way to get the drill size for taps. You can choose from 
common taps or you can enter your own data. Just press Calculate to get the drill size. 
As with the other tools you can edit TAPDRILL.TXT to add your own common taps. 
Metric and Inch are converted for you. 
 

 
 
 

Radius 
 
Click on Radius. This is used to help you compensate for the radius of the tool when 
cutting angles. Input the radius and angle of cut and the amount of compensation is 
calculated for you.  
 
Ex.  R=.0156   Angle=45.    =U-.0183 W.0091 
 
  No Comp    With Comp 
  G1Z0     G1Z0 
  X.4     X.3817(.4-.0183) 
  X.5 Z.05    X.5 Z.0591(.05+.0091) 
  Z.3     Z.3 
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Main Edit Command Buttons (cont.) 
 

Calc 
 
Click on Calc. This is a simple calculator that can also use Trig functions. Your answer 
is displayed when the window is closed. I also added “Hex across corners”  Ex-.5 hex 
stock is .5774 across the corners. 
 

 
 

Trig 
 
Click on Trig. Use Trig to get your angles and programming numbers. Always delete the 
data from the text boxes that you are not using, then you need to have any two sets of 
data and click on Calculate. 
 
1 side and 1 angle 
2 sides 
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Main Edit Command Buttons (cont.) 
 

Machining Data Page 
 
The Machining Data Page is used for the Citizen machines with the Mitsubishi control 
and the B12. It is the special data used by the control to operate, like the Stock Size 
and Machining Length etc. This special data is added to the bottom of the program 
when it is output through the RS232 and is formatted in a special way. The data has to 
go back in to the machine the exact same way. This is an easy way to edit the data 
within WIN-CNC. 
 
To look at the data just click on  Data Pg  and the data will be converted to simple text 
boxes that you can edit. When this window unloads all the data is converted again and 
added to the bottom of the program for you. 
 

 
 

*** Note for L3-16/20 Mitsubishi users if running in Inch *** 
 
There are currently three types of Citizen software for the L3-Series machines that 
format the Machining Data differently between versions. Basically the decimal point is 
moved around. The default for WIN-CNC is Citizen ROM version 115 . To use others 
as default see Command Line Options on page 6 
 
RV109  -Used on all machines with 3600RPM P.O. spindle 
RV112  -Used for a short time and had some decimal point differences from RV109 
RV115  -Used on all type VII machines you must set Mitsubishi param Bit Select #7 bit 
7 to a “1”  to use with WIN-CNC. 
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Make Peck-Drill Sub-Program 
 
Most peck drill cycles are designed for drilling normal holes. As you know, or will soon 
find out, we often have to drill very small holes, very deep, and into very tough 
materials. This part of the software has it's own menu like most of the other functions. 
 
1) Press Alt-r for the Prog menu, press D to call up the Peck Drill Window 
2) Use the Tab Key or the mouse, and to set all the information in the edit boxes. 
3) Choose the Make Peck Sub button and the Files Window (see Pg. 7) is called up. 
Input a file name and the software makes a CNC Sub Program for the drilling. To use 
this CNC Sub-Program, send the file to the CNC machine (see Pg. 23) and use it in 
your CNC program like this... 
 
               Main program             Sub Program # 
               M98 P1234                 O1234 
 
The best way to peck drill is to use  Macro Programming and design a Peck-Drill 
Macro special for your parts. This is easy to change right at the machine to solve 
pecking problems. If you have a L-Series V-VII or E-M Series machines and use the 
User Macro Option, and you would like to try this out, let me know and I'll send you a 
copy of a macro program that works very similar to the peck drill sub in this software 
package. 

 

 
 

Make Engraving Sub Program 
 
1) Press Alt-r for the Prog menu, press E to call up the Engrave Window 
2) Use the Tab Key or the mouse, and to set all the information in the edit boxes. 
3) Press Make CNC Sub and a CNC program is created. 
 
-To designate the type of axis there is a special format used...   ZWR  or  CHP  or  YVD 
-The format is the Absolute axis name, Incremental axis name, Type of axis.  
 
The type of axis can be “R” for radius, “D” for diameter, or “P” for polar. 
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Make Engraving Sub Program (cont.) 
 

 
Example settings… 
   L16/20 engraved so you can read the letters from the operator’s view on a flat. 
 Axis for Height = YVD Direction from top of letter to bottom Height = + 
 Axis for Width = ZWR Direction from left of letter to right Width = + 
 Axis for Depth = XUD Direction into cut = - 
   M20 engraved so you can read the letters from the operator’s view on a flat. 
 Axis for Height = YVR Direction from top of letter to bottom Height = + 
 Axis for Width = ZWR Direction from left of letter to right Width = + 
 Axis for Depth = XUD Direction into cut = - 
   E-32 engraved so you can read the letters from the operator’s view using “C” axis. 
 Axis for Height = CHP Direction from top of letter to bottom Height = - 
 Axis for Width = ZWR Direction from left of letter to right Width = - 
 Axis for Depth = XUD Direction into cut = - 

 
 

CNC Line Numbers 
 
1) Press Alt-C for the CNC menu, press N to call up the Line Numbers Window 
2) Use the Tab Key or the mouse, and to set all the information in the edit boxes. 
3) Press OK and a CNC program is altered. 
 
The CNC codes currently known to need line numbers are... 
 M98 H  M99 P  GOTO  G7? P Q 
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Cut-Off Chamfer 
 

1) Press Alt-r for the Prog menu, press C to call up the Cut-Off Chamfer Window 
2) Use the Tab Key or the mouse, and to set all the information in the edit boxes. 
3) Press OK and the CNC code is created. 

 
 
This was made just to make the programming of the chamfer at the cut-off easy. 
Anyone can do it but this is faster. Simply input the data and then paste the code 
into your program. This will plunge first then do the chamfer and cut-off. 
 

Mill Flats Programming 
 

1) Press Alt-r for the Prog menu, press M to call up the Milling Flats Window 
2) Use the Tab Key or the mouse, and to set all the information in the edit boxes. 
3) Press OK and the CNC code is created. 

 
 

This was developed just to save time. Anyone can program flats but this makes it 
much easier and faster. I used macro programming to save memory in the CNC 
but some machines don’t have macro so you can use standard CNC codes also. 
Just answer the questions and paste the CNC code into your program. 
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Compare CNC Files 
1) Press Alt-F for the File menu, press p to call up the Compare Window 
2) Press Alt-F for the File menu again in the Compare Window 
3) Choose the old and new files to compare. 

 

 
 
Compare was added to be able to find differences in files but on a very simple 
basis. Only whole lines are compared and the left side will be RED and the right 
side will be GREEN with the different text. 
 

Convert CNC Files Inch/MM 
 

1) Press Alt-F for the File menu, press v to call up the Convert Window 
2) Press Alt-F for the File menu again in the Convert Window 
3) Choose the file to be converted and click on Save. 

 

 
 
Most users will run in Inch or Metric but not both because Citizen/Mitsubishi 
machines need parameter changes to change over. For the few that do change 
over their programs need to be changed. This will do that part of the process 
easily. Choose Help About to see which codes are converted. 
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Program Que Checking 
 
 
I added this feature to make your life easier when it you have a complex program with 
many queuing codes and many machining pattern changes. Sometimes the most time 
troubleshooting a job at the machine ends up being a queuing statement was wrong or 
missing! When you are done with your program just start this feature and a window will 
appear showing all the “T” codes, along with any Citizen special codes like G700’s, 
G800’s, !1!2L5 etc. This will also follow the path of the program so when a sub program 
call is used “M98P1234” you may get a message, “You have a M98P sub call. This will 
be skipped and may not report the queues properly.” Most programmers don’t use 
queuing codes in the subs but if you do, you must check them manually. 
 
Codes like “H98H1” and “GOTO100” are read and check just like running on the CNC. 
When a code was called from the “M98H1” the windows will show an (S) next to the 
statement so you can tell it was in the sub. 
 
Just to confirm you used proper “T” codes and didn’t forget to turn on an offset or to 
cancel offsets, the list shows all “T” codes. This can be turned On/Off by the “Option” 
menu.  
 
For a quick flow of the program just cursor down through the codes and the editor will 
jump around to show you where these codes are in each system. If you find a problem, 
this makes it much easier to see when all 2 or 3 lines are pointing to the problem area 
simultaneously. 
 
 
1) Press Alt-R for the File menu, press q to call up the Queuing Window or just click 

on the menu “Prog” then “Check Program Queuing” 
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Send A File To The Machine 
 
1) Choose Comm from the Main Edit Window drop down menu by pressing Alt-M 

then you can either send the current file in the editor to the CNC or you can send a 
different file from disk to the CNC . 

 
2) The communication parameters and machine type are loaded from a special file 

saved in every directory. If you have 2 or more different machines, you only pick the 
file you want to send to the machine and the software makes any necessary changes 
special for that machine. (See Change Parameters Pg. 31).  

 
3) The Communication Window is now active. Press the Send button first, then go to 

the machine and press the keys needed to make the machine ready to receive a 
program. (If there is a problem during communication press the Cancel button and 
you are returned to the Main Edit Window.) 

 

 
 

To Send To L-16 I Yas 110/120 
 
1) At the L-16, go to the Edit Mode.   
 
2) Press the IN key on the L-16 and the program is sent from the computer.  (Only one 

file can be sent at one time.  Sorry but it is a limitation of the machine control.) 
 
 

To Send To L-Series V-VII  /  E/M-Series Mit 
 
1) At the machine go to the DATA SCREEN. Press the INPUT soft key on the CRT 

panel. 
 
2) Input the program type, 1, then cursor to the right DATA field and leave it empty. 
 
3) Press the INPUT key on the main panel and the program is sent from the computer. 

The Program # will appear in the DATA field during communication. 
   Example #(1)         DATA(       _)  INPUT 
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Send A File To The Machine (cont.) 
 
 

To Send To B12 Fanuc 
 
1) At the machine go to the EDIT SCREEN. Press the I/O key on the CRT panel. Now 

press the INPUT key on the CRT panel. 
 
2) Press the  CAN key on the main key pad to clear the data field and leave it empty. 
 
3) Press the INPUT key on the main key panel and the program is sent from the 

computer. You will see the word  INPUT  flashing, indicating the CNC is receiving the 
program. 

 
   Example (1234)   press  CAN        DATA(        ) press INPUT 
 
 

To Send To a L-10 VI Fanuc 16TT 
 
1) Go to the EDIT MODE of the Fanuc. 
 
2) Press the $1 key 
 
3) Press the READ soft key, then the EXEC soft key and the first program is sent from 

the computer to $1. To find READ press the right soft key. 
 
4) Press the $2 key 
 
5) Press the READ soft key, then the EXEC soft key and the second program is sent 

from the computer to $2. To find READ press the right soft key. 
 
 

To Send To a Fanuc 0T,3T,2T 
 
1) Go to the EDIT MODE of the Fanuc. 
 
2) Press the INPUT key and the program is sent from the computer. 
 
 

To Send To a Fanuc 10T 
 
1) Go to the EDIT MODE at the Fanuc. Press the Right Soft Key on the CRT to change 

the menus until you see READ. 
 
2) Press READ then press ALL and the program or programs are sent from the 

computer. 
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Send A File To The Machine (cont.) 
 
 

To Send To L5-16/20 Mitsubishi 
 
1)  At the machine go to the EDIT SCREEN. Press the List key on the CRT panel then 

press I/O. Now press the cursor keys to go to INPUT Communications key and 
press Input on the main panel. 

2)  Select what area to send from the I/O Contents combo box by using the cursor and 
pressing Input. Usually the machining programs is already selected. 

3)  Select the I/O Target combo box by using the cursor and pressing Input. Usually 
the work area is already selected. 

4)  Press Input to get past the Program No. list box because the file name-number will 
come in them the Comm port 

5)  Select a device setting,  Communications Set by using the cursor then press 
Input. Usually use the device called MCC will be used. After you choose one it will 
be the default. This is what sets the parameters for communication. 

6)  Select which port to use from the Input/Output port combo box by using the cursor 
and pressing Input. Usually the Com1 is already selected. 

7)  Now press Input once more on the [Input] command button and communication is 
started. 

8)  If more than one program is needed make the PC ready again and press Input 
again to start communication again. You don’t need to go back to the beginning 

9)  Press Esc to clear the screen. 
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Receive A File From The Machine 
 
1) Choose Comm from the Main Edit Window drop down menu by pressing Alt-M 

then you can either put the data from the CNC in the editor, or you can put the data 
into a file on the disk. 

 
    If saving to a file then input a new file name in the File text box or choose another 

file name from the File list, to overwrite. Press the OK button or (Enter). 
 
   The communication parameters and machine type are loaded from a special file 

saved in every directory. If you have 2 or more different machines, you only pick the 
file you want to receive from the machine and the software makes any necessary 
changes special for that machine. (See Change Parameters Pg. 31). 

 
2) The Communication Window is now active. Press the Receive button first, then go 

to the machine and press the keys needed to make the machine send a program. (If 
there is a problem during communication press the Cancel button and you are 
returned to the Main Edit Window.) 

 
 

To Receive From L-16 I Yas 110/120 
 
1) At the L-16, go to the Edit Mode.   
 
2) Search to the program you want to send at the L-16 by pressing O1234 and then 

press the Right Cursor Key. Your program is now displayed on the L-16 CRT. 
 
3) Press the OUT key on the L-16 and the program is sent to the computer.  (Only one 

program can be sent at one time.  Sorry but it is a limitation of the machine control.) 
 
 

To Receive From L-Series V-VII  /  E/M-Series Mit 
1) At the machine go to the DATA SCREEN. Press the OUTPUT soft key on the CRT 

panel. 
 
2) Input the program type, 1, then cursor to the right DATA field, type in your prog #. 
 
3) Press the INPUT key on the main panel and the program is sent to the computer. 
   Example #(1)         DATA(    1234)  INPUT 
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Receive A File From The Machine (cont.) 
 

To Receive From a B12 Fanuc 
 
1) At the machine go to the EDIT SCREEN. Press the I/O key on the CRT panel. Now 

press the OUTPUT key on the CRT panel. 
 
2) Press the program # (1234)  or use the cursor key to choose the program. 
 
3) Press the INPUT key on the main key panel and the program is sent from the 

computer. You will see the word  OUTPUT  flashing, indicating the CNC is sending 
the program to the computer. 

 
 

To Receive From a L-10 VI Fanuc 16TT 
 
1) Go to the EDIT MODE of the Fanuc. 
 
2) Press the $1 key 
 
3) Press the program # O1234, then press the PUNCH soft key, then the EXEC soft key 

and the program is sent to the computer to $1. To find PUNCH press the right soft 
key. 

 
4) Press the $2 key 
 
5) Press the program # O1234, then press the PUNCH soft key, then the EXEC soft key 

and the program is sent from the computer to $2. To find PUNCH press the right soft 
key. 

 
 

To Receive From a Fanuc 0T,3T,2T 
 
1) Go to the EDIT MODE of the Fanuc. 
 
2) Press the program #O1234, then press the OUT/START(green key) and the 

program is sent to the computer. Press O-9999 to send all programs. 
 
 

To Receive From a Fanuc 10T 
 
1) Go to the EDIT MODE at the Fanuc.  
 
2) Press the program #O1234, then press the Right Soft Key on the CRT to change 

the menus until you see PUNCH. 
 
3) Press PUNCH and the program is sent to the computer. 
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Receive A File From The Machine (cont.) 
 

To Receive From a L5-16/20 Mitsubishi 
 
1)  At the machine go to the EDIT SCREEN. Press the List key on the CRT panel then 

press I/O. Now press the cursor keys to go to Output Communications key and 
press Input on the main panel. 

2)  Select what area to send from the I/O Contents combo box by using the cursor and 
pressing Input. Usually the machining programs is already selected. 

3)  Select the I/O Target combo box by using the cursor and pressing Input. Usually 
the work area is already selected. 

4)  Input the file number or press Input to get past the Program No. edit box. 
5)  If the file was not given above then choose it from the list using the cursor and 

pressing  Input. 
6)  Select a device setting,  Communications Set by using the cursor then press 

Input. Usually use the device called MCC will be used. After you choose one it will 
be the default. This is what sets the parameters for communication. 

7)  Select which port to use from the Input/Output port combo box by using the cursor 
and pressing Input. Usually the Com1 is already selected. 

8)  Now press Input once more on the [Output] command button and communication is 
started. 

9)  Press Esc to clear the screen. 
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Printing A File 
 
1) Choose File from the drop down menu by pressing Alt-F then press P 
2) The Print Window is called up. Press the OK button to print the current file in the 
editor. 
 

 
 
The software first reads the parameters from another file in the directory named WIN-
CNC.PRM. Once this is done.. 
 
-If you have a E or M -Series machine chosen, the file will be printed in 3 columns 
 $1-$2-$3 just like it would look at the machine. 
 
-If you have a L-Series V-VII machine chosen, the file will be printed in 2 columns $1-
$2 just like it would look at the machine. 
 
-If you have Fanuc or Yaskawa machine chosen, then you are prompted to print the 
file in 1 or 2 or 3 columns. Using 3 columns saves paper! 
 
-To change the font and size of the printed CNC program, use “Print Setup” from the 
“File” menu. 
 
-If you use Explorer you can drag a “.CNC” file onto the Print Manager, or it’s icon, and 
the file will print, then exit WIN-CNC automatically. You don’t need to load WIN-CNC. 
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Change Parameters Menu 
 
Every time you run WIN-CNC, a file named WIN-CNC.PRM is examined to determine 
the machine type and communication parameters that are set up for the current DOS 
directory you are in. This will enable you to have many different CNC machines setup in 
different DOS directories and the software then knows the difference from one CNC 
machine and another. Every time you change directories WIN-CNC.PRM is examined 
again in the new directory. 
 
1) Choose Param from the Main Edit Window drop down menu by pressing Alt-P . 

The Comm Param window is now called up. 
 

 
 

2) Choose the Baud Rate, Data Bits, Machine type, and the rest, one at a time. If you 
have a different machine than is listed then see details below... 

 
3) Choose the Save button..., this saves all the parameters in file WIN-CNC.PRM 
 
4) You are now back to the Main Edit Window. 
See pages 33-37 for the CNC's common parameter settings. 
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Troubles Communicating With Non Cincom Machines 
 
1) Choose the Machine Name  Other, and input your own name for this machine. 
 
2) Now set the Communication port, Baud rate, Parity, Word length, and Stop bits, and 

Hand-shake, one at a time. 
 
3) Now choose Set parameters by examining a file.. , this will receive a file from the 

CNC machine and examine it's contents, to determine the rest of the special 
parameters listed in the menu. You can also set all of these by yourself if you know 
what they should be. 

 
4) Do what it says on the screen and send a CNC program from the machine to the 

computer. 
 
5) Press Cancel button  when the CNC is finished sending. Choose the start and end 

of the program by moving the cursor in the text and pressing the command button. 
The parameters are now set. 

 
6) Choose the Save button... , this will save all the parameters in file WIN-CNC.PRM 
 
7) You are now put back into the Main Edit Window. 
 
Common settings are... 
Machine Name ............................................... Other (any name) 
Communications Port ..................................... COM1: 
Baud Rate ......................................................... 4800 
Parity ................................................................... Even 
Data Bits ......................................................... 7 
Stop Bits ......................................................... 2 
Hand Shake ......................................................... XonXoff 
Start Sequence -ASCII ..................................... 18-37-13-10 (DC2,%,LF,CR) 
Char. before program starts  -ASCII ................. 37  (%) 
Program End Character -ASCII ........................... 37  (%) 
End Of Line Sequence -ASCII ........................... 13-10  (LF,CR) 
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L-16I Yaskawa MM 110/120 
 
 Check these parameters...            "X" means leave whatever it was. 
 
bits  7 6 5 4 3 2 1 0 
1004  X X 1 1 X X X X          (end of line  LF) 
1009  0 1 0 1 0 1 0 1           (2 SB  4800 BD) 
 

Fanuc 0T Parameters 
 
 Setting Parameters Page... EIA/ISO= 1     (ISO) 
      I/O=  0 
 Check these parameters...            "X" means leave whatever it was. 
 
bits  7 6 5 4 3 2 1 0 
002  X X X X X 0 X 1 
012  X X X X X 0 X 1 
552  10       (4800 BD) 
553  10       (4800 BD) 
 

Fanuc 3T,2T Parameters 
 
 Setting Parameters Page... EIA/ISO=  1     (ISO) 
      I/O=   0 
 Check these parameters...            "X" means leave whatever it was. 
 
bits  7 6 5 4 3 2 1 0 
005  X X X X X 0 X 1 
014  X X X X X 0 X 1 
068  4800       (4800 BD) 
069  4800       (4800 BD) 
 

Fanuc 10T Parameters 
 
 Check these parameters...            "X" means leave whatever it was. 
 
bits  7 6 5 4 3 2 1 0 
0000  X X X 0 0 X X X 
5110  1 
5111  2         (2 SB) 
5112  10       (4800 BD) 
5120  1 
5121  2         (2 SB) 
5122  10       (4800 BD) 
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L-10 VI Fanuc 16TT Parameters 
 
 Setting Parameters Page... EIA/ISO=  1     (ISO) 
      I/O Channel= 0 
 
 Check these parameters...            "X" means leave whatever it was. 
bits  7 6 5 4 3 2 1 0 
0100  X X X X 1 X X X 
0101  1 0 0 0 0 0 0 1 (2 SB) 
0102  0         (channel) 
0103  10       (4800 BD) 
 

B-12 Fanuc Parameters 
 
To view parameters press the EDIT key ,then the I/O soft key, and then PARM soft key. 
   IN/OUT    PARAM   1P  <PORT> <DEVICE> (DEVICE can =  0-4) 
 #1  DATA IN   1          1       : 
 #2  DATA OUT  1          1       : 
---------------------------------------------------------------------------------------------------------------- 
 IN/OUT    PARAM   2P 
 #    <0> <1> <2> <3> <4> 
   1 BAUD RATE     2 (4800 BD) 
   2 STOP BITS     1 (2 SB) 
   3 PARITY BIT     0 
   4 EVEN PARITY     1 
   5 DATA LENGTH     3 
   6 HARD CONT     1 
   7 DC CODE CONT    1 
   8 DC CODE OUT     1 
   9 TV CHECK     0 
 10 EOB OUT      1 (LF) 
---------------------------------------------------------------------------------------------------------------- 
 IN/OUT    PARAM   3P 
 #    <0> <1> <2> <3> <4> 
   11 LINE FEED     0 
   12 TIME OUT   500 
   13 DATA CODE     1 
   14 DC3 CODE     1 
---------------------------------------------------------------------------------------------------------------- 
(Fanuc Side) Setting Parameters Page...        EIA/ISO= 1(ISO) 
Used for param/offset input/output  I/O Channel= 0 
0100  0 0 0 0 1 0 0 0 
0101  0 0 0 0 0 0 0 1 (2 SB) 
0102  0         (channel) 
0103  10       (4800 BD) 
0134  0 0 0 0 0 0 0 0 
0135  0 0 0 0 0 0 0 0 
0161  0 0 0 0 0 0 0 0 
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L3-Series V-VII / E16J/25J Mitsubishi Meldus 320 
Parameters 

 
To view these parameters press the DATA soft key ,then the MENU soft key, and then 
PARM soft key. 
---------------------------------------------------------------------------------------------------------------- 
 [I/O BASE PARM]       IN/OUT  6.  1/4 
 
 #   <PORT> <DEVICE> 
 1  DATA IN       0          1       :MCC 
 2  DATA OUT      0          1       :MCC 
      (DEVICE can =  0-4) 
---------------------------------------------------------------------------------------------------------------- 
 [ I/O DEVICE PARM(1) ]      IN/OUT  6.  2/4 
 
 #    <0> <1> <2> <3> <4> 
   1 DEVICE NAME   MCC 
   2 BAUD RATE     2   (4800 BD) 
   3 STOP BITS     3   (2 SB) 
   4 PARITY EFFECTIVE    0 
   5 EVEN PARITY     1 
   6 CHR. LENGTH     3 
   7 TARMINATER TYPE    1 
   8      00 
   9      00 
 10 REWIND CODE    00 
 11 HAND SHAKE     3 
 12 DC CODE PARITY    1 
---------------------------------------------------------------------------------------------------------------- 
 [ I/O DEVICE PARM(1) ]      IN/OUT  6.  3/4 
 
 #    <0> <1> <2> <3> <4> 
   1 DC2/DC4 OUTPUT    3 
   2 CR OUTPUT     1 
   3 EIA OUTPUT     0 
   4 TITLE FEED OUT    0 
   5 FEED CHR.     0 
   6 PARITY V      0 
   7 TIME-OUT SET   999 
   8 DATA ASCII     0 
   9 
 10 
 11 
 12 
---------------------------------------------------------------------------------------------------------------- 
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L5-Series Mitsubishi Meldus 600 Parameters 
 

1)  At the machine go to the EDIT SCREEN. Press the List key on the CRT panel then 
press I/O. Now press the cursor keys to go to Communications Parameter key and 
press Input on the main panel. 

2)  At the Input/Output  combo box use the cursor keys and press Input on the device 
you want to change. Usually MCC. 

3)  Set all the data to… 
 
 Device Name: Any name or MCC 
 Baud Rate:  4800 
 Stop Bit:  2 
 Parity:   Even 
 Character Length: 7 
 Hrdware Flow: Invalid 
 Xon/Xoff:  Valid 
 DC Code output: Output 
 TV Check:  Off 
 Eob Out:  CR LF 
 Feed No.:  0 
 Time Out:  500 
 Data Code:  ISO 
 DC3 Code:  0x13 
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E/M-Series Mitsubishi Meldus 330/320/530 Parameters 
 
 
To view these parameters press the DATA soft key ,then the MENU soft key, and then 
PARM soft key. 
 
---------------------------------------------------------------------------------------------------------------- 
 [I/O BASE PARM]       IN/OUT  6.  1/2 
 
 #   <PORT> <DEVICE> 
 1  DATA IN       1          1       :MCC 
 2  DATA OUT      1          1       :MCC 
      (DEVICE can =  0-4) 
---------------------------------------------------------------------------------------------------------------- 
 [ I/O DEVICE PARM(1) ]      IN/OUT  6.  2/2 
 
 #    <0> <1> <2> <3> <4> 
   1 DEVICE NAME   MCC 
   2 BAUD RATE     2   (4800 BD) 
   3 STOP BITS     3   (2 SB) 
   4 PARITY EFFECTIVE    0 
   5 EVEN PARITY     1 
   6 CHR. LENGTH     3 
   7 TARMINATER TYPE    1 
   8      00 
   9      00 
 10 REWIND CODE    00 
 11 HAND SHAKE     3 
 12 DC CODE PARITY    1 
 13 DC2/DC4 OUTPUT    3 
 14 CR OUTPUT     1 
 15 EIA OUTPUT     0 
 16 TITLE FEED OUT    0 
 17 FEED CHR.     0 
 18 PARITY V      0 
 19 TIME-OUT SET   999 
 20-28       0 
---------------------------------------------------------------------------------------------------------------- 
 


